
 

 
Daytona Twin Tec LLC, 933 Beville Road, Suite 101-H, S. Daytona, FL 32119 PC Link TC88 
(386) 304-0700   www.daytona-twintec.com  4/2007 

 Page 1 

         Twin Tec User Instructions for 
PC Link TC88 Software 

CAUTION: CAREFULLY READ INSTRUCTIONS BEFORE PROCEEDING.  
NOT LEGAL FOR USE OR SALE ON POLLUTION CONTROLLED VEHICLES. 

OVERVIEW 
PC Link TC88 software runs under Microsoft 

Windows 98/ME/XP/Vista. The TC88 version of PC 
Link software allows the user to program our ignitions 
for Twin Cam 88® series engines with custom advance 
tables and other engine parameters. An optional USB 
Interface or PC link cable is required is required to 
connect to the existing four terminal Deutsch style data 
link connector on the H-D® wiring harness. PC Link 
TC88 software supports both the original TC88 and 
new TC88A ignitions.  

The new Twin Tec USB Interface P/N USB-INTF 
provides PC connectivity for all of our engine controls 
(ignition and fuel injection systems) and eliminates the 
requirement for multiple cables or a separate USB 
adapter if your laptop is not equipped with an RS-232 
serial port (9 pin male D-sub connector). The USB 
Interface is compatible with Windows 98/ME/XP/Vista.  

If you do not have the new USB Interface, you 
will require one of the original RS-232 PC link cables 
listed below.   

TC88 ignitions for 1999-2003 Twin Cam 88® 
engines require PC link cable P/N TC88-C. 

TC88A ignitions for 2003 and later H-D® models 
with single 12 pin ignition module require PC link cable 
P/N TCFI-C (the same cable used for Twin Tec TCFI 
fuel injection controllers).  

Please note that the TCFI-C and TC88-C PC 
link cables have identifying labels, but otherwise 
appear similar. However, the electrical connections are 
different and the two cables types cannot be 
interchanged. 

Please note that the PC link software cannot 
access restricted private label products other than 
those authorized. 

PC REQUIREMENTS 
If you are using the new Twin Tec USB Interface 

(P/N USB-INTF), refer to the supplied instructions for 
details. No additional hardware is required.  

The original PC link cable connects to an RS-
232 serial port by means of a female 9 pin D-sub 
connector. Data transfer occurs at 56 kBaud. The high 
baud rate limits the maximum cable length and the use 
of an extension cable is not recommended. Due to the 
cable length limitation and the need for portable 
access, a laptop PC is recommended. The PC must 
have a free serial port (COM1-255) with a standard 9 
pin male D-sub connector. If your laptop does not 
include a serial port, you can use a USB adapter. 
However, not all USB adapters will work correctly with 
our PC link cables. Most of the inexpensive USB 
adapters are intended for interfacing Palm Pilot type 
devices and do not support all the signals required by 
our PC link cables.  

We sell and recommend a low cost USB adapter 
(P/N USBG-232) that has been tested with a wide 
range of system configurations. The USBG-232 
adapter comes with correct and updated driver files on 
CDROM. After installation the USBG-232 adapter will 
usually appear as COM5. 

We recommend a laptop with Pentium processor 
and super VGA display (SVGA with 1024 x 768 pixel 
resolution) running Windows 98/ME/XP/Vista. Data 
chart display is graphics intensive and a high speed 
Pentium processor is recommended. Processors 
slower than 300 MHz will exhibit sluggish program 
loading and response. The PC must have a CDROM 
drive for program loading. 

PC Link TC88 includes a print command that 
prints advance table graphics and other engine 
parameters. The program has been tested with 
Hewlett-Packard laser and inkjet printers and Epson 
inkjet printers. We recommend using a color inkjet 
printer.   

SOFTWARE INSTALLATION 
The software is supplied on CDROM media or in 

the form of a compressed file downloaded from our 
website. The installation process uses InstallShield. 
This industry standard installer is based the new 
Microsoft Windows Installer service that greatly 
reduces potential problems such as version conflicts 
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and allows for application self-repair. Since Windows 
98 systems did not originally include the Windows 
Installer service, the required installer software is 
included in the distribution media.  

Before proceeding with installation, shutdown 
any other applications that may be running. For 
Windows Vista, you must disable the User Account 
Control (UAC) during installation. If you are not familiar 
with the UAC, please refer to the Vista UAC Tech Note 
on our website's Tech FAQ for details. 

Use the Windows Explorer or the Run command 
from the Windows Start Menu to launch setup.exe in 
the PC_Link_TC88 folder on the CDROM or the 
setup.exe file downloaded from our website. 
InstallShield will install the software in an appropriate 
folder under Program Files. 

The PC_Link_TC88.cfg file contains access 
codes for restricted private label products. You will only 
be able to access those products for which this file 
contains valid access codes. 

Once InstallShield has completed the 
installation, PC Link TC88 will appear on the Windows 
Start Menu. You can then launch it just as you would 
any other Windows program.  

PC Link TC88 requires the Monospace 821 BT 
fixed pitch printer font in order to properly align 
columns when printing advance tables. The 
Monospace 821 BT font is included in the distribution 
media and automatically copied to your Windows Fonts 
folder during installation. A backup copy is also placed 
in the program folder. If you accidentally delete this 
font, use the Install New Font command from the Fonts 
folder File menu. The filename associated with 
Monospace 821 BT is monos.ttf.      

SOFTWARE OPERATION 
After PC Link TC88 is launched, the main 

screen appears blank. You have three options for 
obtaining advance table data for editing. You can open 
a previously saved advance table file by using the 
Open Table command on the File menu, create a new 
table by using the New Table command on the File 
menu (refer to Figure 1), or download data from an 
attached module by using the Download From 
EEPROM command on the Communications menu. 

Note that advance table data files use a .tbl 
extension. Create a separate folder to store these files.   

Once you have advance table data, you can edit 
the data by clicking on and dragging individual points 
on the 3D chart display (refer to Figure 3) or you can 

directly edit numeric data on the spreadsheet grid. You 
can also rotate the 3D chart display for a better view of 
a particular region.  

After you have completed editing the advance 
table data, you can display and edit the associated 
engine parameters by using the Edit Module 
Parameters command on the Edit menu (refer to 
Figure 4).  

Once the appropriate parameters have been 
entered, you can print the data using the Print Table 
command on the Print Menu. You can save the edited 
advance table by using the Save Table command on 
the File menu.  

You can upload the advance table data and 
engine parameters to an attached module by using the 
Upload to EEPROM command on the Communications 
menu.   

CREATING A NEW ADVANCE 
TABLE  

Use the New Table command on the File menu. 
The dialog box shown in Figure 1 appears.  You can 
enter initial timing and advance slope switch settings. 
Each time you click on Update, the corresponding 
advance table is displayed. The advance values are 
exactly what the module would interpolate from the 
factory programmed minimum and maximum advance 
tables in FLASH memory with the same switch 
settings.  

You will find the New Table command useful for 
generating an advance table that will serve as a 
starting point for further edits. When you are ready to 
proceed with editing, click on OK.  

The New Table command is also useful for 
checking out exactly what advance would be 
generated for any given switch settings.  

Module parameters are not changed when you 
create a new advance table. Always check the 
module parameters after you create a new advance 
table.  
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Figure 1 - Creating a New Advance Table 

 

Editing Table Data 
You can edit table data using standard Windows 

copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit 
menu. You can select cells by dragging the mouse with 
left button down. You can also use the Modify 
command on the pop-up menu. When you enter a 
value, the presence of optional sign (+ or -) or percent 
(%) characters affects the outcome of the Modify 
command.   

Figure 2 – Modify Command  

 

Chart Operations 
You can rotate the 3D chart display for a better 

view of a particular region by dragging the mouse while 
holding both mouse buttons down.  

PC Link TC88 is intended to be an open system 
and uses the Component One Chart 7.0 3D charting 
control. The adventurous user can experiment with the 
chart property pages by right clicking on the chart. 
Almost any chart property can be changed. Click on 
the Help button for more information. If you corrupt the 
chart, exit and restart PC Link TC88.  

Data Export and Import by Means of Drag 
and Drop 

You might want to export or import 3D table 
data to or from another application such as Microsoft 
Excel. Arrange the program windows so that both the 
source and destination are visible (one on the left side 
of the screen and the other on the right side seems to 
work best). You must be able to see the information 
you want to drag as well as the location where you 
want to drop it. To export from PC Link TC88 to Excel, 
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use the left mouse button to select a range of data on 
the spreadsheet grid. Then move the mouse cursor to 
an edge around the selection. Hold the left mouse 
button down and drag the selection into Excel. Release 
the left mouse button on the top left cell in Excel. When 
importing into PC Link TC88 from Excel, use the same 
procedure, except that Excel requires dragging and 
dropping with the right mouse button.   

DOWNLOADING DATA FROM 
EEPROM  

If you are using the new USB Interface, refer to 
the supplied instructions for details. No additional 
hardware is required.  

If you are using the original RS-232 PC link 
cable, connect the cable to the OE data link connector 
and PC serial port. The OE data link uses a four 
terminal Deutsch connector that is usually found near 
the ignition module.  

Turn the ignition key and engine run/stop 
switches on to provide power to the ignition. Do not 
start the engine. 

If the ignition module has been removed from 
the motorcycle, you can do bench top programming by 
using an adapter harness that includes a small 12 volt 
DC power supply.  

COM1 is used as the default port. If you are 
using a different COM port, use the Port Setup 
command on the Communications Menu. 

Download data by using the Download From 
EEPROM command on the Communications menu. If 
you attempt to access a restricted private label module, 
the program will display a warning message and abort 
the download process. Otherwise, the program will 
display the module’s firmware ID.  

If the download process is successful, the 
advance table data will be displayed for editing. 
Module parameters (explained further on) are also 
downloaded and can be displayed using the Edit 
Module Parameters command on the Edit menu.  

Twin Tec ignitions are shipped from the factory 
with a default advance table loaded into EEPROM 
memory. This is the same as the maximum advance 
table stored in permanent FLASH memory. If you have 
never uploaded any custom advance table to 
EEPROM memory, this default table is what you will 
see.  

Please note that no relationship exists between 
the advance data downloaded from EEPROM and any 

switch settings on the module. Also note that the 
minimum and maximum advance tables stored in 
FLASH memory are permanent and cannot be 
changed or directly accessed.  

EDITING ADVANCE TABLE DATA  
Once you have advance table data, you can edit 

the data by clicking on and dragging individual points 
on the 3D chart display (refer to Figure 3) or you can 
directly edit numeric data on the spreadsheet grid.  

The table consists of 16 columns corresponding 
to 500 RPM increments from zero to 7,500 RPM and 8 
manifold pressure (MAP) rows from 16 to 30 In-Hg. 
The 7,500 RPM advance value is used at all higher 
RPM levels and the 16 In-Hg MAP advance value is 
used at all lower MAP levels. 

Note that 16 In-Hg corresponds to a high 
vacuum deceleration or idle condition and that 30 In-
Hg corresponds to wide open throttle (WOT).  Advance 
values must be between zero and 45 degrees. 

You can shift the entire advance table up or 
down by holding the Shift key down while dragging any 
point. The chart label box shows the shift in degrees. 
When you release the mouse button, the chart and 
spreadsheet grid values will be updated. Response of 
the chart label box may be sluggish on slower systems 
due to the amount of data being updated.  

Editing Table Data 
You can edit table data using standard Windows 

copy and paste operations by selecting cells and then 
clicking the right mouse button to pop-up the edit 
menu. You can select cells by dragging the mouse with 
left button down. You can also use the Modify 
command on the pop-up menu. When you enter a 
value, the presence of optional sign (+ or -) or percent 
(%) characters affects the outcome of the Modify 
command as shown in Figure 2.   
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Figure 3 - Editing Advance Data 

 

Chart Operations 
You can rotate the 3D chart display for a better 

view of a particular region by dragging the mouse while 
holding both mouse buttons down.  

PC Link TC88 is intended to be an open system 
and uses the Component One Chart 7.0 3D charting 
control. The adventurous user can experiment with the 
chart property pages by right clicking on the chart. 
Almost any chart property can be changed. Click on 
the Help button for more information. If you corrupt the 
chart, exit and restart PC Link TC88.  

Data Export and Import by Means of Drag 
and Drop 

You might want to export or import 3D table 
data to or from another application such as Microsoft 
Excel. Arrange the program windows so that both the 
source and destination are visible (one on the left side 
of the screen and the other on the right side seems to 
work best). You must be able to see the information 
you want to drag as well as the location where you 
want to drop it. To export from PC Link TC88 to Excel, 
use the left mouse button to select a range of data on 

the spreadsheet grid. Then move the mouse cursor to 
an edge around the selection. Hold the left mouse 
button down and drag the selection into Excel. Release 
the left mouse button on the top left cell in Excel. When 
importing into PC Link TC88 from Excel, use the same 
procedure, except that Excel requires dragging and 
dropping with the right mouse button.   

MODULE PARAMETERS  
Module parameters are displayed in a dialog 

box, as shown in Figure 4, by using the Edit Module 
Parameters command on the Edit menu. Module 
parameters control the overall operation of the ignition 
module.  

When PC Link TC88 is first started, default 
module parameters are loaded. Module parameters 
are updated whenever you download data from an 
ignition module or open an advance table file. Module 
parameters are saved along with the advance table 
data when you save an advance table. Always check 
the module parameters before uploading data to an 
ignition module. 
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Under Options, you can select either EEPROM 
Advance Table or FLASH Advance Tables.  

You must select the EEPROM Advance Table 
option in order to force the module to use a custom 
advance table. If you make this selection, the module 
will use the advance values stored in the EEPROM 
based table, subject to any initial timing or rear cylinder 
offset. The advance slope switch will become inactive. 

If you select the FLASH Advance Tables option, 
the module will use the factory programmed minimum 
and maximum advances tables in permanent FLASH 
memory and interpolate between these two tables 
based on the advance slope switch setting. 

Figure 4 - Editing Module Parameters 

 

Regardless of the advance table selection, you 
can also select the Fixed Initial Timing and/or Fixed 
RPM Limit options. If you select one of these options, 
the corresponding slider control appears and allows 
you to enter a value. Fixed initial timing and RPM limit 
override any module switch settings. These options are 
primarily intended for engine builders and tuners. 

 

 

 

If you select the Fixed Initial Timing option, 
we suggest that you always set the slider to zero 
(nominal setting) to avoid confusion and 
unexpected results. If you use a different setting, all 
the advance values will be shifted up or down. Please 
note that a slider setting of zero corresponds to a 
switch setting of 5.  

Cranking Revs sets the number of engine 
revolutions before the ignitions fires the first spark. 
Most Twin Cam 88 engines will start best with a zero 
setting. Please note that a hot engine may exhibit 
preignition and appear to start on the first revolution 
even if the Cranking Revs parameter is set to a non-
zero value.  

You can also adjust the rear cylinder timing 
offset over a -5 to +5 degree range. Leave the slider 
midrange at zero if you do not require a rear cylinder 
timing offset. 

Please note that the fixed initial timing and rear 
cylinder offset values are read out directly in degrees. 

TC88A Parameters 

The VSS (vehicle speed sensor) frequency 
parameter sets the correct speedometer and odometer 
scaling. Please refer to the following section for more 
details. 

The Enable Tach Output option is applicable to 
TC88A units with firmware revision 2.0 and higher only. 
If you select this option, a 12 volt square wave tach 
signal (one pulse per revolution) will be present on pin 
2 when the engine is running. This tach signal is 
compatible with most tachometers intended for 1999-
2003 Twin Cam 88® applications and allows you to 
retrofit a wide range of tachometers to newer 2004-
2006 models. Selecting this option disables real time 
data display with TC88A Log software.   

SPEEDOMETER CALIBRATION 
(TC88A ONLY)  

The VSS frequency parameter sets the correct 
speedometer and odometer scaling. You can find the 
exact value in the speedometer section of the factory 
service manual for your model. Use the frequency 
value at 100 KPH. Values for most 2004-2006 models 
are given in Table 1. 
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Table 1 – VSS Frequency at 100 KPH 

Model All exc. 
Japan 

Japan 
Only 

Sportster 883 1431 Hz 1635 Hz 

Sportster 1200 1386 Hz 1526 Hz 

Dyna (exc. 
FXDP) 

1424 Hz 1583 Hz 

Dyna FXDP 1435 Hz N/A 

Softail (exc. 
FXSTD) 

1403 Hz 1501 Hz 

Softail FXSTD 1382 Hz 1506 Hz 

Touring Models 
(exc. Police) 

1375 Hz 1493 Hz 

Touring Models 
(Police) 

1435 Hz 1435 Hz 

 

Speedometer Recalibration. You can easily 
recalibrate the speedometer (and odometer) to 
accommodate tire and gear changes. Run the 
motorcycle on a chassis dyno at a constant speed. 
Note the speedometer reading and the correct speed 
indicated on the dyno. Use the following formula to 
calculate the new VSS frequency parameter: 

New VSS Freq  =  Original VSS Freq x Speedo Reading                                 
          Indicated Dyno Speed 

 

For example, if the original VSS frequency 
parameter was 1403 Hz, the speedometer reading is 
60 MPH and the indicated dyno speed is 57 MPH, then 
the new VSS frequency parameter should be: 

  1476 Hz  =  1403 Hz x 60 MPH                                 
               57 MPH 
 

The speed units cancel out, so you can use 
either MPH or KPH units in the calculation as long as 
you use the same units for both the speedometer 
reading and dyno speed. For best accuracy, use a test 
speed near highway cruising speed.   

 

UPLOADING DATA TO EEPROM  
Refer to the Downloading Data from EEPROM 

section on page 4 for details about USB Interface or 
PC link cable hookup and COM port setup. Before 
uploading, make sure the module parameters are 
correct. If you want the module to use a custom 
advance table, you must select the EEPROM 
advance table option as explained on page 6.   

Upload data by using the Upload To EEPROM 
command on the Communications menu. If you 
attempt to access a restricted private label module, the 
program will display a warning message and abort the 
upload process. A status message is displayed when 
the upload process has been successfully completed. 

MODULE SWITCH SETTINGS  
When you upload data, you do not have to 

change any module switch settings except initial 
timing.   

Mode. Original TC88 only. The mode switch 
continues to function normally and allows you to 
enable or disable multi-spark.  

Initial Timing. The initial timing switch continues 
to function normally unless you select the Fixed Initial 
Timing option in the Module Parameters dialog box 
prior to uploading, To avoid confusion and 
unexpected results, we suggest that you always 
set the initial timing switch to 5 (nominal setting) 
after uploading a custom advance table. If you use 
a different setting, all the advance values will be shifted 
up or down. 

Advance Slope. If you select the EEPROM 
Advance Table option in the Module Parameters dialog 
box prior to uploading, the advance slope switch is 
disabled.  

RPM Limit. If you select the Fixed RPM Limit 
option in the Module Parameters dialog box prior to 
uploading, the RPM limit switches are disabled. 
However, on TC88A modules, setting the RPM limit 
switches to zero will disable the module.    

TROUBLESHOOTING FLOWCHART 
Follow the troubleshooting flowchart on the next 

page. Experience has shown that most communication 
problems are user error or PC compatibility issues. 
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Troubleshooting Flowchart 
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